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1. Εισαγωγη στο FDS 

Το Fire Dynamics Simulator (FDS) ειναι ενας αριθμητικος επιλυτης ροης ρευστων με χαμηλο 
αριθμο Mach, αναπτυγμενος απο το NIST (National Institute of Standards and Technology) και 
το VTT Technical Research Centre της Φινλανδιας. Επιλυει τις εξισωσεις Navier-Stokes σε φορμα 
κατασκευη για ανωστικη ροη που κινειται απο πυρκαγια, μοντελοποιωντας καυση, μεταφορα 
θερμοτητας, μεταφορα καπνου και ενεργοποιηση συστηματων πυροπροστασιας. 

 

1.1 Αρχιτεκτονικη και Δυνατοτητες 

• Επιλυτης: χρονικα μεταβαλλομενη, τρισδιαστατη LES (Large Eddy Simulation) σε 
δομημενο ορθογωνιο πλεγμα. 

• Καυση: μοντελο μιξουρας κλασματος με μοντελο θερμικης οκτανης — παρεχει οπτικα 
αδρανη χημεια και πολυβηματικα σχηματα αντιδρασης. 

• Ακτινοβολια: λυση εξισωσης μεταφορας ακτινοβολιας με μεθοδο διακριτων 
τεταρτεμοριων (DTM). 
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• Εναλλαγη θερμοτητας στερεων: μεταγωγη θερμοτητας μονοδιαστατη μεσα σε εμποδια, 
τυρβωδης μεταφορα θερμοτητας στα ορια. 

• Πυρολυση: πολυστρωματα στερεα με αντιδρασεις θερμικης αποικοδομησης. 

• Σταγονιδια: Lagrangian σωματιδια για νερο εκτοξευτηρων, αερολυματα καπνου. 

• Παραλληλισμος: MPI μεσω πολλαπλων μπλοκ πλεγματος. 

 

1.2 Δομη Αρχειου Εισοδου (.fds) 

Ενα αρχειο εισοδου FDS ειναι απλο κειμενο ASCII που αποτελειται απο εγγραφες namelist της 
μορφης: 

&NAMELIST  ΠΑΡΑΜΕΤΡΟΣ1='τιμη',  ΠΑΡΑΜΕΤΡΟΣ2=αριθμος  / 

 
Καθε εγγραφη αρχιζει με & ακολουθουμενο απο το ονομα ομαδας namelist και τελειωνει με /. 
Σχολια ξεκινουν με !. Η σειρα των εγγραφων δεν εχει συνηθως σημασια εκτος απο τη &HEAD 
που πρεπει να ειναι πρωτη. 

 

1.3 Ελαχιστη Δομη Αρχειου 

&HEAD CHID='ονομα_εργου', TITLE='Περιγραφη' / 
&MESH IJK=50,50,30, XB=0,5, 0,5, 0,3 / 
&TIME T_END=120. / 
&MISC TMPA=20. / 

 
! Ορισμος γεωμετριας 
&OBST XB=0,5, 0,0.2, 0,3  SURF_ID='INERT' /  ! τοιχος 

 
! Οριακες συνθηκες 
&VENT XB=0,5, 0,5, 0,0  SURF_ID='FLOOR' /     ! δαπεδο 
&VENT XB=0,5, 5,5, 0,3  SURF_ID='OPEN'  /     ! ανοιχτο ορισμος 

 
! Αρχικοποιηση πυρκαγιας 
&SURF ID='ΦΩΤΙΑ', HRRPUA=500. / 
&OBST XB=2,3, 2,3, 0,0.05  SURF_IDS='ΦΩΤΙΑ','INERT','INERT' / 

 
! Εξοδοι 
&SLCF PBZ=1.5  QUANTITY='TEMPERATURE' / 
&DEVC XYZ=2.5,2.5,2.0  QUANTITY='TEMPERATURE'  ID='Θερμ_κεντρο' / 

 
&TAIL / 

 

1.4 Κυριες Ομαδες Namelist — Επισκοπηση 

Namelist Σκοπος Κυριες Παραμετροι 

&HEAD Ταυτοτητα εργου CHID (αναγνωριστικο), TITLE 
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Namelist Σκοπος Κυριες Παραμετροι 

&MESH Ορισμος υπολογιστικου 
πλεγματος 

IJK (αριθμος κελιων), XB (εκταση) 

&TIME Παραμετροι χρονου T_END, DT, RESTART 

&MISC Διαφορες παγκοσμιες 
παραμετροι 

TMPA, GVEC, HUMIDITY 

&REAC Ορισμος αντιδρασης καυσης FUEL, SOOT_YIELD, CO_YIELD, 
HEAT_OF_COMBUSTION 

&SURF Ιδιοτητες επιφανειας HRRPUA, TMP_FRONT, VEL, THICKNESS 

&MATL Ιδιοτητες υλικου DENSITY, CONDUCTIVITY, SPECIFIC_HEAT 

&OBST Γεωμετρια εμποδιου XB, SURF_ID/SURF_IDS, BULK_DENSITY 

&HOLE Αφαιρεση γεωμετριας XB, CTRL_ID 

&VENT Οριακη συνθηκη επιπεδης 
εδρας 

XB, SURF_ID, DYNAMIC_PRESSURE 

&DEVC Συσκευη/αισθητηρας XYZ, QUANTITY, ID, SETPOINT 

&SLCF Αρχειο τομης (2D 
απεικονιση) 

PBX/Y/Z ή XB, QUANTITY 

&BNDF Αρχειο οριακης συνθηκης QUANTITY 

&ISOF Ισοεπιφανεια QUANTITY, VALUE 

&PART Σωματιδια Lagrange SPEC_ID, DIAMETER, MASSLESS 

&HVAC HVAC δικτυο βλ. Ενοτητα 4 

&TAIL Τελος αρχειου 
(υποχρεωτικο) 

— 

 
 

2. Ρυθμιση Πλεγματος & Γεωμετρια 

Το FDS χρησιμοποιει δομημενο, ορθογωνιο πλεγμα. Η ποιοτητα πλεγματος επηρεαζει απευθειας 
την ακριβεια αποτελεσματων, οποτε η σωστη επιλογη μεγεθους κελιου ειναι κρισιμη. 

 

2.1 Ορισμος Πλεγματος (&MESH) 

&MESH ID='Πλεγμα_1', 
      IJK=100, 60, 40, 
      XB=0.0, 10.0,  0.0, 6.0,  0.0, 4.0 / 

 
! IJK: αριθμος κελιων στους αξονες X, Y, Z 
! XB:  xmin, xmax, ymin, ymax, zmin, zmax (σε μετρα) 
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Συμβουλη: Για βελτιστη αποδοση, χρησιμοποιηστε διαστασεις IJK που ειναι γινομενα αριθμων 2, 3 η 
5 (π.χ. 40, 60, 120). Αποφευγετε πρωτους αριθμους. 

 

2.2 Επιλογη Μεγεθους Κελιου — Κριτηριο D* 

Η χαρακτηριστικη διαμετρος πυρκαγιας D* ορισμοποιει την απαιτουμενη αναλυση πλεγματος: 

D* = [ Q / (rho_inf * Cp * T_inf * sqrt(g)) ]^(2/5) 

 
Τυπικες τιμες για κοινα σεναρια: 
  Q =  100 kW (μικρη πυρκαγια καλαθιου)  →  D* ≈ 0.40 m  →  dx ≈ 4 cm 
  Q =  500 kW (μεσαια πυρκαγια δωματιου) →  D* ≈ 0.74 m  →  dx ≈ 7 cm 
  Q = 2000 kW (μεγαλη πυρκαγια)          →  D* ≈ 1.13 m  →  dx ≈ 11 cm 

 
Στοχος: D*/dx = 10 (βασικη)  η  16 (υψηλη ακριβεια) 

 

2.3 Πολλαπλα Πλεγματα & Παραλληλισμος 

Για μεγαλους τομεις η εκτελεση σε υπολογιστικο συμπλεγμα, οριστε πολλα μπλοκ πλεγματος. 
Κανονες: 

• Τα γειτονικα πλεγματα πρεπει να μοιραζονται κοινη πλευρα (συνεπιπεδα κελια στο 
οριο). 

• Το FDS εκχωρει αυτοματα MPI διεργασιες σε πλεγματα κατα σειρα αναφορας (&MESH 
#1 → κορος 0, #2 → κορος 1 κ.λπ.). 

• Επιδιωξτε παρομοιο αριθμο κελιων ανα πλεγμα για ισορροπια φορτιου. 

• Χρησιμοποιηστε MPI_PROCESS για χειροκινητη αναθεση αν απαιτειται. 

! Εκτελεση FDS με 4 MPI διεργασιες: 
mpiexec -n 4 fds ονομα_αρχειου.fds 

 

2.4 Γεωμετρια Εμποδιων (&OBST & &HOLE) 

! Τοιχος με συγκεκριμενη επιφανεια 
&OBST XB=0.0,0.2, 0.0,5.0, 0.0,3.0  SURF_ID='INERT' / 

 
! Εμποδιο με διαφορετικες επιφανειες (πανω, πλαγια, κατω) 
&OBST XB=1.0,3.0, 1.0,3.0, 0.0,0.8 
      SURF_IDS='ΦΩΤΙΑ','INERT','INERT' / 
!          πανω   πλαγια  κατω 

 
! Αφαιρεση ανοιγματος (πορτα) 
&HOLE XB=0.0,0.2, 1.0,1.9, 0.0,2.1 / 

 

Προσοχη: Τα εμποδια ευθυγραμμιζονται αυτοματα με τα ορια κελιων πλεγματος. Αν η εισαγωγη 
γεωμετρια δεν ευθυγραμμιζεται, το FDS την στρογγυλοποιει — ελεγξτε το αρχειο .out για συνοψη. 
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3. Επιφανειες, Υλικα & Καυση 

Οι επιφανειες (&SURF) ορισμουν τη συμπεριφορα των οριων: τι κανει ο τοιχος, το δαπεδο η η 
οροφη. Τα υλικα (&MATL) ορισμουν τις θερμοφυσικες ιδιοτητες για συμπυκνωμενη-φαση φυσικη. 

 

3.1 Τυποι Επιφανειων 

Τυπος Βασικες Παραμετροι Παραδειγμα Χρησης 

Αδρανης (Inert) BACKING='VOID' η 'EXPOSED' Τοιχοι, δαπεδα, εμποδια 

Καυστηρας HRRPUA [kW/m2], RAMP_Q Πυρκαγιες λιμνης, καυστηρες 

Παροχη Αερα VEL [m/s], TMP_FRONT [°C] Εισαγωγη αερα, εκτοξευτηρες 

Στρωματωμενο MATL_ID, THICKNESS [m] Τοιχοι, επιπλα (πυρολυση) 

Ανοιχτο (Open) — Ατμοσφαιρικο ορισμος 

Θερμοκρασια TMP_FRONT [°C] Θερμαινομενα ορια 

Καθρεφτης — Επιπεδα συμμετριας 

 

3.2 Ορισμος Καυστηρα με Ανοδο t² 

! Προφιλ χρονου: ανοδος t^2 σε 60s, αιχμη 500 kW/m2 
&RAMP ID='RAMP_HRR', T=0,   F=0.   / 
&RAMP ID='RAMP_HRR', T=60,  F=1.   / 
&RAMP ID='RAMP_HRR', T=300, F=1.   / 
&RAMP ID='RAMP_HRR', T=360, F=0.   / 

 
&SURF ID='ΚΑΥΣΤΗΡΑΣ_T2', 
      HRRPUA=500., 
      RAMP_Q='RAMP_HRR', 
      COLOR='ORANGE' / 

 

3.3 Πυρολυση Στερεων — Στρωματωμενες Επιφανειες 

! Ορισμος υλικου ξυλου 
&MATL ID='ΞΥΛΟ', 
      DENSITY=600.,             ! kg/m3 
      CONDUCTIVITY=0.14,        ! W/m/K 
      SPECIFIC_HEAT=1.7,        ! kJ/kg/K 
      REFERENCE_TEMPERATURE=350., 
      HEAT_OF_REACTION=150.,    ! kJ/kg 
      NU_FUEL=0.7, 
      NU_RESIDUE=0.3, 
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      RESIDUE='ΑΝΘΡΑΚΑΣ' / 

 
&MATL ID='ΑΝΘΡΑΚΑΣ', 
      DENSITY=100., 
      CONDUCTIVITY=0.05, 
      SPECIFIC_HEAT=1.0 / 

 
&SURF ID='ΕΠΙΦΑΝΕΙΑ_ΞΥΛΟΥ', 
      MATL_ID(1,1)='ΞΥΛΟ', 
      THICKNESS(1)=0.02,        ! 2 cm παχος 
      BACKING='INSULATED' / 

 

3.4 Ορισμος Αντιδρασης Καυσης (&REAC) 

! Πολυπροπυλενιο (PP) 
&REAC ID='ΠΟΛΥΠΡΟΠΥΛΕΝΙΟ', 
      FUEL='PROPYLENE', 
      C=3., H=6., 
      SOOT_YIELD=0.022, 
      CO_YIELD=0.024, 
      HEAT_OF_COMBUSTION=43200. /   ! kJ/kg 

 

Προσοχη: Χρησιμοποιηστε τιμες SOOT_YIELD και CO_YIELD απο πειραματικα δεδομενα (π.χ. 
SFPE Handbook). Η προεπιλογη τιμη CO_YIELD = 0 υποεκτιμα την τοξικοτητα σε ανεπαρκη αερισμο. 

 
 

4. Συσκευες, Εξοδοι & Ελεγχος 

Ο σωστος ορισμος εξοδων ειναι κρισιμος: δεν μπορουν να ανακτηθουν δεδομενα που δεν 
ζητηθηκαν πριν την εκτελεση. Σχεδιαστε προσεκτικα τις θεσεις αισθητηρων και τις ποσοτητες 
εξοδου. 

 

4.1 Συσκευες Σημειου (&DEVC) 

! Θερμοκρασια σε σημειο 
&DEVC ID='Θ_1.5m', XYZ=3.0,2.0,1.5  QUANTITY='TEMPERATURE' / 

 
! Ανιχνευτης καπνου (ενεργοποιηση σε 3.24 %/m) 
&DEVC ID='Ανιχν_1', XYZ=5.0,2.5,2.8 
      QUANTITY='CHAMBER OBSCURATION' 
      SETPOINT=3.24,  LATCH=.TRUE. / 

 
! Καταιονητηρας (ενεργοποιηση σε 68°C) 
&DEVC ID='Sprink_1', XYZ=4.0,4.0,2.9 
      QUANTITY='SPRINKLER LINK TEMPERATURE' 
      SETPOINT=68.,  LATCH=.TRUE. 
      PART_ID='ΝΕΡΟ_ΣΤΑΓ' / 
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! Συνολικος HRR στο πεδιο 
&DEVC ID='HRR_ΟΛΙΚΟΣ', XB=0,10, 0,6, 0,4 
      QUANTITY='HEAT RELEASE RATE' / 

 

4.2 Κοινες Ποσοτητες Συσκευων 

Ποσοτητα Μοναδες Περιγραφη 

TEMPERATURE °C Θερμοκρασια αεριου σε σημειο 

VELOCITY m/s Μετρο ταχυτητας 

VISIBILITY m Ορατοτητα (μοντελο Purser) 

LAYER HEIGHT m Υψος οριου στρωματος καπνου 

UPPER TEMPERATURE °C Μεση θερμοκρασια ανω στρωματος 

HEAT FLUX kW/m2 Συνολικη ροη θερμοτητας στην 
επιφανεια 

OXYGEN mol/mol Τοπικο κλασμα O2 

CARBON MONOXIDE mol/mol Τοπικη συγκεντρωση CO 

SOOT DENSITY mg/m3 Πυκνοτητα αιθαλης 

HEAT RELEASE RATE kW HRR σε ογκο η παγκοσμιος 

 

4.3 Αρχεια Τομης (&SLCF) & Οριων (&BNDF) 

! Οριζοντια τομη σε υψος 1.5m — θερμοκρασια 
&SLCF PBZ=1.5  QUANTITY='TEMPERATURE' / 

 
! Κατακορυφη τομη στο Y=3.0 — ταχυτητα Z 
&SLCF PBY=3.0  QUANTITY='W-VELOCITY' / 

 
! Πληρης τρισδιαστατη τομη (προσοχη: μεγαλα αρχεια) 
&SLCF XB=0,10, 0,6, 0,4  QUANTITY='VISIBILITY' / 

 
! Αρχεια οριακης επιφανειας — ροη θερμοτητας σε τοιχους 
&BNDF QUANTITY='GAUGE HEAT FLUX' / 
&BNDF QUANTITY='WALL TEMPERATURE' / 

 

4.4 Λογικος Ελεγχος (&CTRL) 

Το FDS υποστηριζει λογικους ελεγκτες για ενεργοποιηση/απενεργοποιηση vents, καυστηρων η 
συσκευων βασει συνθηκων. Αυτο επιτρεπει μοντελοποιηση συστηματων καταιονητηρων, 
θυροφυλακτων και αλλων αυτοματισμων. 

! Ενεργοποιηση ανεμιστηρα ταν ανιχνευθει καπνος 
&CTRL ID='ΕΛΕΓΚΤΗΣ_ΑΝΕΜ', FUNCTION_TYPE='ANY', 
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      INPUT_ID='Ανιχν_1' / 

 
&VENT ID='ΕΞΑΓΩΓΗ_ΚΑΠΝΟΥ', XB=8,10, 0,6, 3.9,4.0 
      SURF_ID='ΕΞΑΓΩΓΗ', CTRL_ID='ΕΛΕΓΚΤΗΣ_ΑΝΕΜ' / 

 
 

5. HVAC & Εξαερισμος στο FDS 

Το FDS υλοποιει ενα μοντελο δικτυου HVAC που επιλυει αγωγους, ανεμιστηρες και φιλτρα 
ταυτοχρονα με τη ροη του πλεγματος CFD. Τα στοιχεια συνδεονται στο CFD πλεγμα μεσω 
κομβων. 

 

5.1 Βασικα Στοιχεια HVAC 

! Κομβος στο CFD πλεγμα (εσωτερικος) 
&HVAC TYPE='NODE',  ID='Κομβος_Εξαγ', 
      DUCT_ID='Αγωγ_Κυρ', 
      VENT_ID='ΕΞΑΓΩΓΗ_1', 
      LOSS=0. / 

 
! Κομβος στο CFD πλεγμα (εξωτερικος) 
&HVAC TYPE='NODE',  ID='Εξωτ_Περιβ', 
      AMBIENT=.TRUE. / 

 
! Αγωγος που συνδεει δυο κομβους 
&HVAC TYPE='DUCT',  ID='Αγωγ_Κυρ', 
      NODE_ID='Κομβος_Εξαγ','Εξωτ_Περιβ', 
      DIAMETER=0.5, 
      LENGTH=10., 
      LOSS=0.5, 0.5 / 

 
! Ανεμιστηρας (καμπυλη ροης-πιεσης) 
&HVAC TYPE='FAN',  ID='ΑΝΕΜΙΣΤΗΡ_1', 
      DUCT_ID='Αγωγ_Κυρ', 
      MAX_FLOW=5.0,     ! m3/s 
      MAX_PRESSURE=500. /  ! Pa 

 

5.2 Απλος Αεραγωγος Εξαγωγης 

! Vent που συνδεεται με κομβο HVAC 
&VENT ID='ΕΞΑΓΩΓΗ_1', XB=4.0,6.0, 5.9,6.0, 2.5,3.0 
      SURF_ID='HVAC' 
      QUANTITY='HVAC_VAL' 
      HVAC_ID='Κομβος_Εξαγ' / 

 

5.3 Απλα Ανοιγματα (χωρις HVAC) 
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Για φυσικο εξαερισμο χωρις μηχανικα συστηματα, OPEN vents στα ορια πλεγματος ειναι αρκετα. 
Για εισαγωγη/εξαγωγη μηχανικου αερα χωρις δικτυο αγωγων: 

! Παροχη αερα σε συγκεκριμενη ταχυτητα 
&SURF ID='ΠΑΡΟΧΗ_ΑΕΡΑ', 
      VEL=-0.5,         ! m/s (αρνητικο = εισοδος στο πεδιο) 
      TMP_FRONT=20. / 

 
! Εξαγωγη με καθορισμενο ογκο 
&SURF ID='ΕΞΑΓΩΓΗ_ΑΕΡΑ', 
      VOLUME_FLUX=2.5 /  ! m3/s 

Προσοχη: Βεβαιωθειτε οτι η ισορροπια ογκου μεταξυ εισαγωγης και εξαγωγης εχει νοημα φυσικα. 
Ανισορροπια οδηγει σε μεγαλες πιεσεις που επηρεαζουν τη σταθεροτητα. 

 
 

6. Εκτελεση & Παρακολουθηση FDS 

 

6.1 Εκτελεση απο Γραμμη Εντολων 

! Μονοπλεγματικη εκτελεση 
fds ονομα_αρχειου.fds 

 
! Παραλληλη εκτελεση με 4 πυρηνες (MPI) 
mpiexec -n 4 fds ονομα_αρχειου.fds 

 
! Παρασκηνιο σε Linux/macOS 
nohup fds ονομα_αρχειου.fds > log.txt 2>&1 & 

 
! Ελεγχος εγκυροτητας αρχειου (χωρις εκτελεση) 
fds -p ονομα_αρχειου.fds 

 

6.2 Βασικα Αρχεια Εξοδου 

Αρχειο Περιεχομενα & Χρηση 

CHID.out Κυριο αρχειο εξοδου — συνοψη ρυθμισεων, 
λαθη, σταθερες FDS 

CHID.err Μηνυματα σφαλματος — ΠΑΝΤΑ ελεγχετε μετα 
την εκτελεση 

CHID_hrr.csv Ρυθμος αποδεσμευσης θερμοτητας ανα χρονικο 
βημα 

CHID_devc.csv Ολα τα αποτελεσματα DEVC — εισαγωγη σε 
Excel/Python 

CHID_evac.csv Δεδομενα εκκενωσης (αν χρησιμοποιειται EVAC) 
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Αρχειο Περιεχομενα & Χρηση 

CHID.smv Αρχειο σκηνης Smokeview — ανοιγμα για 
οπτικοποιηση 

CHID_*.sf Δεδομενα τομης (δυαδικα) 

CHID_*.bf Δεδομενα οριακης επιφανειας (δυαδικα) 

CHID.end Δημιουργειται στο τελος — επιβεβαιωση 
ολοκληρωσης 

 

6.3 Ερμηνεια Αρχειου .out 

Το αρχειο CHID.out εχει τρεις κυριες ενοτητες: 

• Επικεφαλιδα: εκδοση FDS, ημερομηνια, αριθμος πυρηνων, πλεγματα, κελια. 

• Συνοψη Χρονικου Βηματος: εμφανιζεται περιοδικα — δειχνει χρονο t, Δt, μεγιστη 
ταχυτητα CFL, και εκτιμωμενη ολοκληρωση. 

• Συνοψη Εξοδου: λιστα ολων των &DEVC, &SLCF, &BNDF που ζητηθηκαν. 

 

Προσοχη: Ελεγξτε παντα το CHID.out για γραμμες 'WARNING' η 'ERROR'. Κοινες προειδοποιησεις: 
'MESH ALIGNMENT', 'OPEN BOUNDARY', 'LARGE VELOCITY ERROR'. 

 

6.4 Επαναεκκινηση Προσομοιωσης 

! Στο αρχειο .fds: ενεργοποιηση επαναεκκινησης 
&TIME T_END=600., RESTART=.TRUE. / 

 
! Δημιουργεiται αρχειο επαναεκκινησης αυτοματα: 
! CHID_XXXX.rst  (καθε N βηματα, οπου N ρυθμιζεται στο &DUMP) 

 
 

7. Εισαγωγη στο Smokeview 

Το Smokeview (SMV) ειναι το επισημο εργαλειο τρισδιαστατης οπτικοποιησης για το FDS, 
αναπτυγμενο παραλληλα απο το NIST. Αποδιδει γεωμετρια, ισοεπιφανειες, τομες, σωματιδια και 
οπισθεδρομα δεδομενα συσκευων σε πραγματικο χρονο η ωρα ανα ωρα. 

 

7.1 Διεπαφη Smokeview 

Στοιχειο Περιγραφη 

Κυριο Παραθυρο Τρισδιαστατη οπτικοποιηση — αριστερο κλικ + 
σερσιμο για περιστροφη 
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Στοιχειο Περιγραφη 

Δεξι Κλικ Μενου Κυριο μενου για φορτωση δεδομενων, ελεγχο 
χρονου, εγγραφη 

Μπαρα Χρονου Αναπαραγωγη/παυση, ολισθηση σε συγκεκριμενο 
χρονο 

Γραμμη Κατασταση Εμφανιζει τρεχοντα χρονο t, κατευθυνση βλεψης, 
φωτισμο 

 

7.2 Πλοηγηση 

• Περιστροφη: αριστερο κλικ + σερσιμο 

• Μετατοπιση: μεσαιο κλικ + σερσιμο η Shift + αριστερο κλικ 

• Μεγεθυνση: τροχος κυλισης 

• Επαναφορα προβολης: πληκτρο R 

• Αξονες X/Y/Z: πληκτρα X, Y, Z για προκαθορισμενες κατοψεις 

 

7.3 Φορτωση Δεδομενων 

1. Ανοιξτε το Smokeview με διπλο κλικ στο αρχειο CHID.smv. 

2. Δεξι κλικ στο κυριο παραθυρο → Load/Unload → επιλεξτε τυπο δεδομενων. 

3. Για τομες: Load/Unload → Slices → επιλεξτε ποσοτητα (π.χ. Temperature) → επιλεξτε 
αρχειο. 

4. Για ισοεπιφανειες: Load/Unload → Isosurfaces → επιλεξτε ποσοτητα και τιμη κατωφλιου. 

5. Για σωματιδια: Load/Unload → Particles. 

 

Συμβουλη: Φορτωστε μονο τα δεδομενα που χρειαζεστε — η ταυτοχρονη φορτωση πολλων αρχειων 
τομης καταναλωνει πολυ μνημη RAM. 

 
 

8. Οπτικοποιηση & Αναλυση στο Smokeview 

 

8.1 Τομες (Slice Files) 

Τα αρχεια τομης εμφανιζουν χρωματικες απεικονισεις ποσοτητων σε επιπεδα. Ελεγχος 
χρωματικης κλιμακας: 

• Δεξι κλικ → Colorbar → Set Min/Max για ορισμο ορισμος κλιμακας. 

• Δεξι κλικ → Colorbar → Contour για εμφανιση ισογραμμων. 
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• Πληκτρο C εναλλασσει τη χρωματικη κλιμακα μεταξυ συνεχους και διακριτης. 

 

8.2 Ισοεπιφανειες 

Ισοεπιφανειες οπτικοποιουν τριδιαστατα αντικειμενα σε συγκεκριμενη τιμη (π.χ. ισοεπιφανεια 
θερμοκρασιας 500°C για ορισμος φλογας). 

• Δεξι κλικ → Load/Unload → Isosurfaces → επιλεξτε ISOF αρχειο. 

• Ρυθμιστε αδιαφανεια μεσω Render → Opacity για ολοκληρωμενη οπτικοποιηση με 
τομες. 

 

8.3 Σωματιδια & Καπνος 

Σωματιδια Lagrange αναπαριστουν καπνο, σταγονιδια νερου η ανιχνευτες. Για καλυτερη 
απεικονιση: 

• Δεξι κλικ → Options → Particles → αυξηστε Factor για πυκνοτερο καπνο. 

• Ενεργοποιηστε Smokeview → Render → Smooth για λειοτερη απεικονιση. 

 

8.4 Δεδομενα Συσκευων (Γραφηματα Χρονοσειρας) 

Το Smokeview μπορει να εμφανισει γραφηματα χρονοσειρας DEVC δεδομενων κατευθειαν στο 
παραθυρο: 

6. Δεξι κλικ → Show Devices → επιλεξτε συσκευη. 

7. Εμφανιζεται γραμμη χρονοσειρας στην οθονη με ρυθμιζομενη θεση. 

8. Για πολλαπλες συσκευες, χρησιμοποιηστε το εξωτερικο εργαλειο Fsmv η εισαγωγη 
_devc.csv στο Excel/Python. 

 

8.5 Αποθηκευση Εικονων & Βιντεο 

Στιγμιοτυπο: 
  Πληκτρο P  →  αποθηκευει PNG με ονομα CHID_XXXX.png 

 
Ακολουθια εικονων: 
  Δεξι κλικ → Render → Render Frames 
  Ορισμος βηματος χρονου και φακελου εξοδου 

 
Μετατροπη σε βιντεο (με FFmpeg): 
  ffmpeg -framerate 10 -i CHID_%04d.png -c:v libx264 video.mp4 

 

8.6 Αρχεια Ρυθμισεων Smokeview (.ini) 
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Το Smokeview αποθηκευει ρυθμισεις προβολης (γωνια καμερας, φορτωμενα δεδομενα, 
χρωματικες κλιμακες) σε αρχειο CHID.ini. Αυτο επιτρεπει αναπαραγωγιμη οπτικοποιηση και 
κοινοποιηση ρυθμισεων με συναδελφους. 

Συμβουλη: Πριν μοιραστειτε αποτελεσματα, αποθηκευστε ρυθμισεις Smokeview μεσω File → Save 
→ ini file. Ο παραληπτης ανοιγει το .smv και φορτωνει το .ini για πανομοιοτυπη προβολη. 

 
 

9. Επικυρωση & Ποιοτητα Αποτελεσματων 

Η επικυρωση FDS αποτελεσματων ειναι υποχρεωτικη στη μηχανικη πρακτικη. Η τεχνικη 
βιβλιογραφια και ο NIST παρεχουν ολοκληρωμενες βασεις δεδομενων επικυρωσης. 

 

9.1 Αναλυση Ευαισθησιας Πλεγματος 

Εκτελεστε τουλαχιστον τρεις προσομοιωσεις με διαφορετικη αναλυση πλεγματος (χονδρο, 
βασικο, λεπτο) και συγκρινετε βασικα μεγεθη: 

Αναλυση D*/dx Χρονος Εκτελεσης Αποκλιση HRR 

Χονδρο 5 ~10' ±15% 

Βασικο 10 ~2h ±5% 

Λεπτο 16 ~12h <2% 

 

9.2 Σχεση Ομοιωσης (Fire Froude Number) 

Fr* = Q / (rho_inf * Cp * T_inf * sqrt(g) * D^(5/2)) 

 
  Fr* >> 1 : ελεγχομενη ωθηση (βαρυτητα ασθενης) 
  Fr* ~  1 : μεταβατικο καθεστως 
  Fr* << 1 : πυκνοτητα-ελεγχομενη ροη 

 
Στοχευστε D*/dx >= 10 σε ολες τις περιοχες με Fr* ~ 1. 

 

9.3 Ελεγχοι Μετα την Εκτελεση 

• Ελεγξτε το ενεργειακο ισοζυγιο στο CHID.out: η ολοκληρωμενη HRR πρεπει να 
συμφωνει με την καυση καυσιμου. 

• Συγκρινετε μεγιστες θερμοκρασιες με αναλυτικες εκτιμησεις (π.χ. στρωμα καπνου 
McCaffrey). 

• Ελεγξτε οτι τα αρχεια εξοδου δεν περιεχουν 'NaN' η 'Inf' τιμες. 

• Επαληθευστε ρυθμους ροης αεραγωγου εναντι σχεδιασμενων τιμων. 
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Συμβουλη: Ο NIST δημοσιεψει FDS Validation Guide (NIST SP 1018) με εκατοντες δοκιμες 
επικυρωσης. Χρησιμοποιηστε τον για αξιολογηση της ακριβειας για τον τυπο σεναριου σας. 

 
 

Παραρτημα Α — Αντιμετωπιση Κοινων Σφαλματων 
FDS 

Σφαλμα / Προβλημα Αιτια & Λυση 

STOP: MESH ALIGNMENT Τα πλεγματα δεν ειναι ευθυγραμμισμενα. 
Βεβαιωθειτε οτι τα κελια στα ορια εχουν ιδιο 
μεγεθος. 

STOP: NUMERICAL ERROR Ασταθης λυση λογω πολυ μεγαλου Δt. Μειωστε 
HRRPUA η μεγεθος κελιου. 

WARNING: LARGE VELOCITY ERROR Ροη σε οριο πλεγματος. Αυξηστε buffer η 
προσθεστε OPEN vent. 

Αρχειο .end δεν δημιουργειται Η προσομοιωση δεν ολοκληρωθηκε. Ελεγξτε .err 
για αιτια. 

Εξαιρετικα μικρα βηματα χρονου CFL > 1. Βελτιωστε πλεγμα η μειωστε ταχυτητες 
εισοδου. 

Smokeview: κενη οθονη Ελεγξτε οτι .smv βρισκεται στον ιδιο φακελο με 
.sf/.bf. 

_devc.csv: τιμες NaN Συσκευη εξω απο πλεγμα η σε εμποδιο. 
Διορθωστε XYZ. 

Απεριοριστη μνημη RAM Μειωστε αριθμο ταυτοχρονα φορτωμενων τομων 
στο Smokeview. 

 

Παραρτημα Β — Χρησιμες Εντολες FDS 

! Εκτελεση 
fds αρχειο.fds                        ! μονοεπεξεργαστης 
mpiexec -n N fds αρχειο.fds           ! N MPI διεργασιες 
fds -p αρχειο.fds                     ! μονο συνταξη ελεγχος 

 
! Χρησιμα εργαλεια μετα την εκτελεση 
fds2ascii -chid CHID -slcf 1           ! τομη σε ASCII 
smokeview CHID.smv                     ! ανοιγμα αποτελεσματων 

 
! Python για αναλυση _devc.csv 
python3 -c " 
import pandas as pd, matplotlib.pyplot as plt 
df = pd.read_csv('CHID_devc.csv', skiprows=1) 
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df.plot(x='Time', y='Θ_1.5m') 
plt.savefig('θερμοκρασια.png') 
" 

 

Παραρτημα Γ — Μετατροπεις Μοναδων 

Ποσοτητα FDS Μοναδα Μετατροπη 

Θερμοκρασια °C K = °C + 273.15 

Ρυθμος Θερμοτητας kW 1 kW = 1000 W = 3412 BTU/h 

HRRPUA kW/m2 1 kW/m2 = 317 BTU/h/ft2 

Παχος m 1 m = 100 cm = 39.37 in 

Πυκνοτητα kg/m3 1 kg/m3 = 0.0624 lb/ft3 

Ειδικη Θερμοτητα kJ/kg/K 1 kJ/kg/K = 0.239 BTU/lb/°F 

Αγωγιμοτητα W/m/K 1 W/m/K = 0.578 BTU/h/ft/°F 

 

Παραρτημα Δ — Χρησιμοι Ποροι 

• FDS Οδηγος Χρηστη (NIST SP 1019): https://pages.nist.gov/fds-smv/ 

• FDS Τεχνικη Αναφορα (NIST SP 1018): https://pages.nist.gov/fds-smv/ 

• Smokeview Οδηγος Χρηστη: https://pages.nist.gov/fds-smv/manuals.html 

• Ομαδα Συζητησης FDS-SMV: https://groups.google.com/g/fds-smv 

• SFPE Handbook of Fire Protection Engineering — βασικες συσχετισεις 

• CFAST (ζωνικο μοντελο, συμπληρωματικο του FDS): https://pages.nist.gov/cfast/ 

• Thunderhead Engineering (PyroSim): https://www.thunderheadeng.com 
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